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3Filling Out Forms
Forms contain areas where you enter information. These areas are called cells. The form de
creates and names each cell using the Informed Designer application. The form designer als
ifies the type of information that you can store in each cell, as well as the desired formatting 
options. Calculations, choices, lookups, and other intelligent features are also added to a form
Informed Designer.

This chapter describes how to fill out a form. You’ll learn about entering information and abou
using the variety of intelligent features that make it easy for you to fill out a form. You can fill 
new records or you can edit existing records. For information about creating, finding, removin
duplicating, and sorting records, see Chapter 8.

Activating a Record
Before you can change the information on a form, you must activate the current record. While a 
record is active, you can tab from cell to cell and enter information by typing on the keyboard
pasting from the Clipboard. The figure below shows a form that’s inactive (left) and active (rig

The small pencil in the collection information box (see “Collection of Records” in Chapter 8) 
cates visually that the record is active. Notice that the Sold To cell is selected and ready to a
information. The form on the left is inactive and therefore has no current cell.

Activating a Record



 

Filling Out Forms 3-3

 .
 .

 .

 

 or 
he 

  

selects 

  

utton. 
u 
r 

ng or 
rma-

 you 
longer 
ntain a 
nter 

 on a 

  

you 
nvalid 
alid 

ecord.

ls by 
ell 

  

. 
r a 

ls con-

   

uto-

 

.

When you open an existing form data document, or when you retrieve a record using the find
browsing commands (see Chapter 8), the current record will be initially inactive. To activate t
current record, you can do either of the following:

■   Press the Tab key. When you press Tab, Informed Filler activates the current record and 
the first cell on the current page.

■   Click any cell. Using the mouse, position the pointer over any cell, then press the mouse b
Informed Filler activates the record and shows a blinking insertion point in the cell that yo
clicked. If you click a checkbox, picture, or signature cell, you’ll see a bold, blinking borde
inside the cell instead of a blinking insertion point.

Once you’ve activated a record, you can enter information by tabbing from cell to cell and typi
pasting values. See “Entering Information” and “Tab Order” later in this chapter for more info
tion.

Accepting the Current Record
After you’ve entered a new record or made changes to the information on an existing record,
accept the record by pressing the Enter key on the numeric keypad. The pencil indicator no 
appears and the current cell on the form is deselected. If your Windows keyboard does not co
numeric keypad, you can press Control-Enter. If your Mac OS computer does not have an E
key, you can press Command-Return.

As you’ll learn later in this chapter, the form designer can create check formulas for the cells
form. A check formula is a formula that examines the value of a cell to check for errors. When 
attempt to accept a record, Informed Filler checks for errors in order to prevent accepting an i
record. If an error is detected, a beep will sound and the record will remain active with the inv
cell value selected. Correct the mistake, then press the Enter key once again to accept the r

Entering Information
To fill out a form you enter information into each cell on the form. You can move between cel
pressing keys such as Tab or Shift-Tab, or by clicking a particular cell with the pointer. The c
which is currently selected is called the current cell; it’s the cell that’s ready to accept information
With the exception of checkbox, picture, and signature cells, the current cell will contain eithe
blinking insertion point or a selected cell value. Selected checkbox, picture, and signature cel
tain a bold, blinking outline.

Accepting the Current Record

Note If you choose a command such as Print or Close while a record is active, Informed Filler a
matically accepts the record before performing the command.

Entering Information
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After selecting a cell, you can enter information into it by:

■   typing

■   pasting the Clipboard contents (choose Paste from the Edit menu)

■   selecting a choice from a choices palette or drop-down list (for certain cells)

For information about using choice lists, see “Intelligent Features” later in this chapter.

As you enter information, Informed Filler can help by automatically calculating, looking up, a
checking values for you. These and other intelligent features make it easier to fill out forms qu
and accurately.

Each cell on your form will accept a particular type of information. The form designer is respo
ble for properly naming and choosing the most appropriate type for each cell. Informed allow
use of nine different cell types. The following table lists these types with examples.

Cell Types

When you enter information into a cell, the value you type or paste must be appropriate for th
of information that the cell holds. For example, you can’t type a name into a cell that stores n
bers. If you enter an incorrect cell value, Informed Filler will beep and select the value when 
attempt to accept the record or tab to a different cell.

Cell Type Examples

Text
Character
Number
Name
Date
Time
Boolean

Picture

Signature

Business form #29
(555) 555-1212
101
Mr. John Smith
10/25/89
14:20
Yes

12345 - 123 Street, A Big City
02983-1283
$12,550.75
Jones, Mr. Tom F.
Wednesday, November 8, 1989
03:15:04 PM

Blinking insertion point

Bold, blinking outline
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Associated with each cell type are a variety of formatting options that make it easier to enter
mation. Rather than typing formatted values, Informed Filler can do the formatting for you. Fo
example, a cell might be formatted to display numbers with a currency symbol, thousand sep
tors, and two decimal places of accuracy. Informed Filler would automatically convert a typed
value, such as ‘1500,’ to the formatted value ‘$1,500.00.’

Font, Size, and Type Style

The form designer specifies the font, size, and type style attributes used to display informatio
each cell on the form. When you enter a value in a cell, the information is always displayed a
ing to those specifications. However, by selecting certain options, the form designer can allo
to change these attributes cell by cell.

To change the font, size, or type style, select the value in a cell and choose a new setting fro
submenus under the Cell menu. Which submenus are available depends on which options th
designer has allowed. For example, if you are only allowed to change the font and type style
Size submenu will be unavailable.

The following types styles are not available on Windows compatible computers: Outline, Sha
Condensed, and Extended.

Display Only Cells

The form designer can prevent you from entering information into any cell by making the cell
play only. Display only cells are usually calculated cells that obtain their values from other ce
the form. While tabbing from cell to cell, Informed Filler will skip past any display only cells. Y
are still permitted, however, to select a display only cell by clicking it with the pointer. To indic
that a cell is a display only cell, a line will appear through the pencil symbol in the collection i
mation box when the cell is selected.

While a display only cell is selected, Informed Filler will beep each time you try to enter or ch
the cell’s value. After three attempts, an alert message will notify you that the current cell is a
play only cell.
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Entering Text

The text cell type is used for cells that hold textual information such as an address, a comme
memo. Formatting options can automatically capitalize letters, words, or sentences in the inf
tion you enter.

When you enter information into a cell, you can type more lines than will actually fit in the ce
area. When you press Tab to move to the next cell, the information that doesn’t fit is hidden.

Text cells can also make use of a formatting option called ‘Allow auto-shrink.’ If this option is 
selected, Informed Filler will automatically shrink the type size of the information so that it fits
entirely in the cell area.

Entering Character Values

The character cell type also stores textual values. However, unlike the text cell type, characte
ues must match a specific format that the form designer defines. The character cell type is u
commonly to store information such as telephone numbers, zip codes, or any values that are
formatted exactly the same way.

When you enter a value into a character cell, Informed Filler will verify that the value matche
cell’s format. Format characters such as dashes and spaces are automatically entered for you
enter an incorrect value, Informed Filler will beep and select the value when you try to move 
different cell or accept the record. A message will appear picturing the required format.

Entering Numbers

The number cell type stores numbers in a variety of formats. Informed Filler automatically for
any number you enter according to the cell’s format. Format characters such as the currency
bol, thousand separators, and the decimal point are entered for you.

Entering Names

The name cell type stores names. A name has up to five parts: a prefix (such as Mister or Pro
a first name, a middle name, a last name, and a suffix (such as Junior). Multiple prefixes, mid
names, and suffixes are allowed. A cell’s name format can include all parts or only selected p
either full or abbreviated form.
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When you enter a name, Informed Filler identifies each part that you type, then formats the n
according to the cell’s name format. You should enter the parts of a name in the following ord
prefix, first name, middle name, last name, then suffix. If you type a comma after the first par
Informed Filler will interpret that part as the last name.

To help identify the parts of a name that you type, Informed Filler refers to a list of known pre
and suffixes. This list can be found in Appendix A of this manual.

Entering Dates and Times

Informed Filler makes it easy to enter dates and times. Rather than typing a value in a particu
mat, you can type a date or time in any format you like. For example, to enter the date ‘Janu
1996,’ you can type ‘jan 1 96’ or ‘1 1 96.’ Informed Filler interprets what you type and formats
date or time value according to the particular formatting options of the cell.

Since today’s date is often a common entry for a date cell, Informed Filler offers a command
types the current date for you. To enter the current date, select the cell that you want to type i
choose Insert Date from the Edit menu. Informed Filler enters today’s date in the correct form

Entering Boolean Values

A boolean cell can have one of two values. Depending on the format of a boolean cell, the ce
value will display as Yes or No, True or False, or On or Off.

Informed Filler ensures that you enter only values that are appropriate for that format. If you 
only part of a value, Informed Filler converts it to its full form. For example, to enter ‘No’ into a
Yes/No style boolean cell, you need only type the letter ‘n.’ Informed Filler converts the value
‘No’ for you.

Entering Checkbox Values

There are eight different checkbox styles. The following table lists each style in its checked a
unchecked state.
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Rather than typing a value into a checkbox, simply click the cell with the pointer or press any
The cell’s value will toggle between checked and unchecked.

Entering Pictures

You can enter a picture into a picture cell by using the Insert File command (see “Reading Inf
tion From a File”) or by pasting from the Clipboard. If you are using a Mac OS compatible co
puter with system software 7.5 or later, you can also enter a picture by using the drag and dr
method. Informed Filler stores pictures in Windows Bitmap (.BMP), Windows Metafile (.WMF
Macintosh PICT (.PCT), and Encapsulated PostScript (.EPS).

The Windows Metafile format is not supported on the Mac OS.

Reading Information From a File

Another way to fill in parts of a form is to use the Insert File command. This command allows
to import a text file into a text cell, or a picture into a picture cell. For the command to be avail
the current cell must be a text or picture cell, and its ‘Display only’ option must be turned off.

To insert a file, select the cell, then choose Insert File... from the Cell menu. For picture cells only,
pressing the Enter (Windows) or Return (Mac OS) key is a shortcut for selecting the Insert F
command. The standard Open dialog appears, allowing you to select a file. For text cells, the
selected text file will be inserted into the cell at the current insertion point. For picture cells, th
selected picture replaces the current picture in the cell.

Setting a Cell’s Value for Multiple Records

From time to time you might want to set the value of a single cell on more than one record. F
example, if a customer pays ten outstanding invoices with one check, you have to mark each
invoice as being paid. Instead of changing the value of the ‘Payment Status’ cell from ‘Unpai
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‘Paid’ on each record individually, you can set the value of the cell for all ten records at once 
the Set Value command.

To set the value of a cell on multiple records, find and show that collection of records on the R
List. Make sure that the Record List contains only the records that you want to change (see C
8, “Manipulating Records” for details about the collection of records and using the Record Li
With the Record List displayed, select the column that contains the cell you want to change, 
choose Set Value... from the Cell menu. The Set Value dialog box appears.

With the ‘This value’ option selected, enter the new value in the text box and click ‘OK.’ The v
of the cell is changed for each selected record. If you are setting the value for many records,
Informed Filler displays a progress dialog.

If you want to change the value for a checkbox cell, the Set Value dialog box will look like this

Instead of typing a value, simply click either the ‘Checked’ or ‘Unchecked’ option.

Note If the selected column on the Record List corresponds to a table cell on the form, the ‘This
value’ option will not be available. You can only use the ‘Its calculated value’ option. Please 
“Calculations” for more details.
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You can use the Set Value command to change the value of any cell except for display only c
picture and signature cells. If the cell or Record List column that you select is one of these, t
Value command will be unavailable.

You can also use the Set Value command to reset the value of a calculated cell. For details, 
“Calculations” later in this chapter. 

Errors When Using the Set Value Command

As you’ll learn in “Data Verification” later in this chapter, the form designer can create a chec
mula for any cell so that Informed Filler automatically checks for mistakes when you fill out a
form. A check formula is a formula that examines a cell value to determine if an error has bee
made.

When you use the Set Value command to change a cell’s value for many records, it’s possibl
the value you set might be invalid for one or more records in the collection, based on the cell
check formula. If this occurs, Informed Filler leaves those records unchanged and tags them
the tag name “Set Value Errors.” For information on tagging records, see “Tagging Records” 
Chapter 8.

Scrolling Fields

The form designer can include a scroll bar with any field on the form. A field that includes a s
bar is called a scrolling field. A scrolling field allows you to enter more data than will display in th
cell area. You view all the data by scrolling up and down using the scroll bar.

Depending on which option the form designer has chosen, the scroll bar on a scrolling field m
be visible at all times, or only when you select or tab into that cell.

When a record that contains scrolling fields is filled out and printed, Informed Filler repeats th
printing of the page or pages that contain the scrolling fields, until all the data in those fields 
been printed. For example, if page 2 of a two page form contains a scrolling field, Informed F
will print page 1, then page 2, then page 2 again until all the data in the scrolling field has be
printed. The extra copies of page 2 will only contain the data in the scrolling field; all other fie
will print blank.

The scroll bar is active, indicating
that the cell area contains more data.
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Memorizing Values
Many forms contain information that is specific to the person filling out the form. For example
you fill out a time card, information such as your name or employee number is always the sa
Instead of typing an entry each time, you can type an entry once, and use Informed Filler’s M
rize command to “memorize” that value. The next time you add a new record to your data do
ment, the “memorized” value is automatically filled in.

To memorize a value, select the value in the cell, then choose Memorize from the Cell menu. The 
value you are memorizing appears as part of the Memorize command in the Cell menu. For 
ple, if you fill in the value “Lynn Gweenie” in the ‘Name’ cell on your form, the Memorize com
mand displays as Memorize ÒLynn GweenieÓ when the cell is selected. After choosing the 
Memorize command, the name “Lynn Gweenie” will be automatically filled in when you add a 
record to your data document.

Often different types of forms will contain some common information. For example, both purc
requisition and travel expense forms contain cells for employee information. For a particular 
employee, this information is the same on every record, both for purchase requisitions and tr
expense forms. If the form designer has selected the ‘Memorization is shared’ option for a pa
lar cell (such as the ‘Name’ cell), any value that you memorize for that cell is also memorized
the same cell on other forms.

To cancel the effect of memorization, simply memorize a blank value.

Tab Order
Each form has a predefined tab order. The tab order determines the order in which you move fro
cell to cell each time you press the Tab key. The form designer sets up the tab order using In
Designer. You can’t change a form’s tab order using Informed Filler. The following figure illustr
tab order.

Memorizing Values

Note A cell’s memorized value is shared only if the ‘Memorization is shared’ option is selected b
the form designer. The memorized value is shared only with cells on other forms that have
same cell name and the ‘Memorization is shared’ option selected.

Tab Order



 

3-12 Filling Out Forms

 .
 .

 .

 

order. 
n one 
e to a 

) has 

 out 

  

 pre-
lls 

ere-
nd-
Tab 

 con-
red in 
s for 
box 
 
s 

 table 
tion 

rm 

 

.

When you fill out a form, pressing the Tab key moves you from one cell to the next in the tab 
Pressing the Shift-Tab key moves you in the reverse direction. If your form contains more tha
page, Informed Filler will automatically change pages when you move from a cell on one pag
cell on another.

For cells that cannot have more than one line, pressing Enter (Windows) or Return (Mac OS
the same effect as pressing Tab.

Informed’s Quick-Tab feature allows you to bypass the normal tab order of a form. While filling
a form, pressing F2 (Windows) or Command-Tab (Mac OS) moves you to the next Quick-Tab cell 
in tab order. Pressing Shift-F2 (Windows) or Command-Shift-Tab (Mac OS) moves you to the
vious Quick-Tab cell instead. Like the tab order of a form, you can’t change the Quick-Tab ce
using Informed Filler. Quick-Tab cells are specified using Informed Designer.

The first row of the first column cell in every table is automatically a Quick-Tab cell. You can th
fore automatically move from table to table on your form by pressing either of the F2/Comma
Tab or Shift-F2/Command-Shift-Tab keys. The first field cell following a table is also a Quick-
cell.

The form designer might also have configured conditional tabs for certain cells on the form. A
ditional tab moves you to another area of the form, based on the information that you’ve ente
the cell you’re tabbing out of. For example, the form designer might configure conditional tab
‘Local’ and ‘Out of Town’ checkboxes on a travel expense form. If you select the ‘Local’ check
and then tab from that cell, you might tab past sections for claiming expenses such as ‘Hotel
Accommodation’ and ‘Airline Travel,’ and go directly to sections for claiming expenses such a
‘Parking’ and ‘Fuel.’

Filling Out Tables
Each table on your form consists of one or more columns and one or more rows. You fill out a
by tabbing from column to column and row to row, entering information in each cell. The direc
that you tab in a table—either across the rows or down the columns—is configured by the fo
designer.

Filling Out Tables

ABC Company
12233-44 Ave.
New York, NY
98765

INVOICE

Sold To Ship To

Date Terms PO Number Ship Via

Signature

Qty Description Price

Shipping
Total

No.

1 2

3 54 6

7 8 9 10

11

12

The circled numbers indicate
an appropriate tabbing order
for this form.
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The form designer also specifies when tabbing will leave a table. Normally, if you are tabbing
across the rows, tabbing leaves the table when you tab through one empty row. However, the
designer can also configure the tab order so that tabbing leaves the table after you tab out of 
column of an empty row.

Inserting and Removing Rows

Occasionally you may want to insert or remove a row in a table that already contains informa
Informed Filler provides the Insert Row and Remove Row commands specifically for this purp
As an example, consider the table of information shown in the following figure.

Suppose that you want to add a new row between items A0-032 and A0-007. Simply select a
in the row containing item A0-007, then choose Insert Row from the Edit menu. Informed Filler 
will move all rows starting at the one containing the current cell down by one, then insert a bl
row.

If the last row in the table already contains information, Informed Filler won’t let you insert a n
row. Instead, you’ll see this message:
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Before you can insert a row in a full table, you have to clear the information on the last row.

To use the Remove Row command, select any cell in the row that you want to remove and c
Remove Row from the Edit menu. Informed Filler moves the information in all remaining rows
by one row.

Expandable Rows in Tables

If the form designer has selected the ‘Expandable rows’ option for a table, the spacing of indiv
rows can expand if you enter more data than the chosen row spacing can display. With this o
selected, all rows in the table are expandable, but only the rows that contain extra data are a
For example, if only one row in a table contains more information than it could normally displ
only that row will expand. The other rows will retain their original spacing.

If all the rows in a table already contain data, Informed Filler will not allow you to expand any r
in the table, since that would cause the last row of the table to disappear. If you try to expand
when all rows in the table already contain data, you’ll be alerted with a message.

Scrolling Tables

The form designer can include a scroll bar with any table on the form. A table that includes a 
bar is called a scrolling table. Informed Filler automatically adds new rows to the scrolling table
when you enter more data than the table can display. You can view all the data in the table by
ing up and down using the scroll bar.

Depending on which option the form designer has chosen, the scroll bar on a scrolling table 
be visible at all times, or only when you select or tab into the table.

When a form that contains scrolling tables is filled out and printed, Informed Filler repeats th
printing of the page or pages that contain the scrolling tables, until all the data in those table

Only the row with extra
information expands. All
other rows retain their
original spacing.

You can view all
the information by
using the scroll bar.
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been printed. For example, if page 2 of a two page form contains a scrolling table, Informed 
will print page 1, then page 2, then page 2 again until all the data in the scrolling table has be
printed. The extra copies of page 2 will only contain the data in the scrolling table; all other fi
will print blank.

Using Buttons
As an alternate method for invoking commands and actions, the form designer can include b
on your form templates. Clicking a button invokes a command or action according to the butt
configuration.

Clicking a button will often perform a command just as though you choose the command from
menu. For example, the mail button on the form above provides an alternative method for sel
Informed Filler’s Send command. Other buttons might select settings or perform custom actio
specified by the form designer.

Like menu commands, a button is available only when its associated command or action is p
ted. For example, if a button is configured to reveal the next record in the data document, this
will be unavailable if the current record is the last record.

Pages of a Form
Each form has a work page and at least one numbered page. The numbered pages contain 
form’s actual design. For example, the first and second pages of a two page form are the num
pages. A form can have a maximum of 99 numbered pages, and each page can have as ma
parts.

The number of pages and the number of parts per page is determined during the design pro
using Informed Designer. You can’t change these attributes of a form using Informed Filler.

Using Buttons

Pages of a Form

Clicking this button mails the form by
invoking Informed Filler’s Send command.
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The Work Page

Every form contains one work page. Like the numbered pages of a form, the work page can c
graphics, text, and cells. The only difference between the work page and numbered pages is 
work page doesn’t print when you print a form. For instructions on how to print the work page
please see “Printing the Work Page” in Chapter 9.

There are two common uses of the work page.

■   As a place to put instructions or information that’s useful while filling out a form. For exam
suppose there are special instructions for distributing a form after it has been filled out. Yo
might find these instructions on the work page.

■   As a place to put cells that should not print with the rest of the form. You may need to ent
calculate cells that don’t appear on the form (but are required by other calculated cells). F
example, you might find the employee wage rates for a check form on the work page.

When you fill out a form, the work page functions like any other numbered page. You can Tab
cells on the work page and change their values. When you print the form, the work page doe
print.

Changing Pages

As you fill out a form, Informed Filler automatically changes pages when you tab from a cell 
one page to a cell on a different page. You can also use the page controls located along the 
of the document window to change pages.

The control labelled ‘W’ represents the work page. The rightmost control represents the curre
numbered page of your form. When the numbered page control is selected, the number insid
corresponds to the current numbered page in the document window.

Using the page controls, you can change pages in either of two ways.

■   Click either arrow next to the numbered page control to change pages in that direction. If
click and hold either arrow, Informed Filler will continue changing pages in that direction u
you release the mouse button. If you’re on page 1, the left arrow disappears. If you’re on th
numbered page of the form, the right arrow disappears.
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■   Double-click the numbered page control. The Change Page dialog box appears.

Type the number of the page that you wish to change to, then click ‘OK.’ Informed Filler move
directly to the requested page.

After changing pages, the number shown in the page control will change to reflect the curren

To change to the work page, simply click the work page control. Clicking the numbered page
trol changes back to the numbered pages of the form.

Intelligent Features
Informed’s data intelligence features make it easy to fill out forms quickly and accurately. Wit
Informed Filler, forms can automatically format, calculate, look up, and verify data so that yo
don’t have to. The following figure shows a completed form with various intelligent features id
fied.

Intelligent Features

Auto-incrementing
numbers

Sold To Ship ToABC Company
12345 - 123 St
New York, NY
15243

Date Terms Ship ByPO No.

INVOICE

Qty Part Description Price Ext.

Shipping
Total

Mr. Smith
8273 Long Way
San Francisco, CA
27363

Mr. Smith
27364 Short Way
San Francisco, CA
82734

9/14/96 Cash UPS

2 872 Gadgets 79.23 158.46
12 231 Widgets 771.10 9,253.20

$9,419.66
8.00

Invoice # 552

Default to
today’s date

Lookup in 
another form
or data source

Offer a list of choices

Calculate cells
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As explained in “Informed Documents” (see Chapter 2), the template of a form consists of bo
graphical appearance of the form as well as its intelligent features. The form designer sets u
intelligence of a template using Informed Designer.

The remaining sections in this chapter explain how to use the intelligent features of a form.

Calculations

Informed Filler automatically fills in calculated cells. A calculated cell is a cell that obtains its 
value based on other cells on your form. A cell’s calculation formula is evaluated whenever the 
value of any cell that participates in the formula changes. For example, suppose that a cell c
‘Extension’ is calculated as ‘Quantity * Price.’ Whenever you type a different value in either of
‘Quantity’ or ‘Price’ cells, Informed Filler automatically calculates and displays the new value 
‘Extension.’

As explained in “Display Only Cells” earlier in this chapter, the form designer can prevent you
from changing the value of any cell—including a calculated cell—by making the cell display o
If a calculated cell is not display only, you can change its value like any other cell. For examp
you have an invoice with a calculated cell called ‘Discount,’ on occasion you might want to gi
customer more than the calculated discount. If the cell is non-display only, you can manually
ride the calculated value by typing a different value. To change the cell back to its calculated 
simply select the cell on the form or the column on the Record List and choose Set Value... from 
the Cell menu.

When the Set Value dialog box appears, click the ‘Its calculated value’ radio button, then clic
‘OK.’

Data Verification

The form designer can enter error checking rules for any cell so that Informed Filler will auto
cally check for mistakes as you fill out a form. Each time you enter a cell value, Informed Fill
checks the value according to the cell’s check formula. A check formula is a formula that examines 
a cell value to determine if an error has been made. For example, a check formula might che
ensure that a cell’s value is within a particular range.
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Some check formulas detect errors, whereas others warn you of specific conditions. In any c
you’ll hear a beep when you try to select a different cell or accept the record. Some check for
will even present an alert dialog box with a message. Others will add a message to the cell’s
dialog (see “Help Messages for Cells”). The following figure shows an alert dialog box.

Once an error has been reported, Informed Filler will allow you to move to a different cell eve
without first correcting the mistake. However, you can’t accept, mail, or print a record until all
errors have been corrected. If you try to do so, a beep will sound and the record will remain a
with the incorrect value selected. An alert dialog box may appear with a message describing
mistake you’ve made.

Whenever an alert dialog box appears, Informed Filler will automatically add the message to
cell’s help dialog box. This allows you to later view the alert message by selecting the cell the
choosing Help... from the Cell menu. See “Help Messages for Cells” later in this chapter for m
information.

Choice Lists

Often a cell will take on a variety of common values. For example, the shipping method on an
form might always be Mail, UPS, or Federal Express. The form designer can enter a list of ch
for any cell. Instead of typing a cell value, you can simply select a choice.

Depending on how the form designer has configured a cell’s choice list, the choices are disp
either in a palette or in a drop-down list.

Note If you’re unaware of how to correct an error, you can always revert or remove the record. F
more information, see Chapter 8, “Manipulating Records.”
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If the choices for a cell are configured to display in a drop-down list, you’ll see an arrow on th
right side of the cell’s title section, indicating the presence of a choice list.

To display the choice list, click the arrow and hold the mouse button down.

Depending on how the form designer has set up the form, choices in a palette will display au
ically when you tab into the cell, or you may have to choose Show Choices from the View menu. If 
you show the palette by choosing the Show Choices command, the palette will remain visible
you close it manually by choosing Hide Choices or by clicking the palette’s close box. If the palett
is set to display automatically, Informed Filler will also hide the palette for you automatically w
you select a different cell or accept the record.

The form designer can add descriptive text to a cell’s list of choices that won’t appear in the c
once a choice is made. For example, if you select the choice ‘TurboMail (0003),’ only the text
parenthesis, in this example ‘0003,’ will appear in the cell.

Choices for ‘Ship Method’
displayed in a drop-down list

Choices for ‘Ship Method’ 
displayed in a palette

Choice list indicator
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Selecting a Choice

Depending on whether a choice list is displayed in a drop-down list or in a palette, you use dif
methods to select a choice.

To make a selection from a drop-down list, simply click the arrow indicator on the cell’s title s
tion and drag the mouse until the choice you want is highlighted. When you release the mou
ton, your choice appears in the cell.

When choices are displayed in a palette, you can select a choice by double-clicking it in the 
by using the Up and Down arrow keys.

Another convenient way to select a choice from either a choices palette or a drop-down list is
type the first few characters of the value. As you type characters, Informed Filler selects the c
that most closely matches the typed value. For example, suppose that the sales person cell o
slip has the choices listed in the following table.

Sales Person Choices

Typing the letter ‘D’ would select ‘Dawson, Greg,’ the first choice that starts with that letter. Typ
‘Da’ would also select ‘Dawson, Greg.’ However, typing ‘Di’ would select ‘Dickens, Sharon’ 
instead. In each case, Informed Filler automatically copies the entry into the cell as the selec
made.

The only exception to this is when you type the first characters of choices that have descriptiv
added to them. For example, if you have TurboMail (0003) as one of the choices, typing the 
‘T’ selects the choice in the list but doesn’t automatically display the value (0003) until you tab
of the cell.

Once you’ve selected the correct choice, press Tab to accept the selected choice and move 
next cell. If you press Tab without selecting a choice, Informed Filler leaves the cell blank an
moves to the next cell.

Sales Person Choices

Brown, Tom
Dawson, Greg
Dickens, Sharon
Johnson, Cindy
Murphy, Karen
Smith, John
Young, Kevin
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Editing a Cell’s Choices

Although you can’t edit or remove the original choices in a choice list, the form designer can 
you to add extra items to the list of choices for any cell. If adding extra choices to a cell’s choic
is allowed, the Extra Choices command under the Cell menu will be available when the cell i
selected. To add more choices to a choice list, choose Extra Choices... from the Cell menu. The 
Edit Choices dialog box appears.

The Edit Choices dialog box contains controls for adding, removing, and changing extra cho
To add a new choice, type the entry in the text box below the scrolling list and click ‘Add.’ The
choice is added to the list in sorted order. Although there’s no practical limit to the number of
choices a cell can have, we recommend that you enter no more than 40 or 50.

To change or remove an extra choice, first select the choice by clicking it in the scrolling list; 
selected choice appears in the text box. To remove the selected choice, click ‘Delete.’ To chan
selected choice, type the new value then click ‘Change.’

After you’ve entered all choices for the selected cell, click ‘OK’ to dismiss the Edit Choices di
box. The next time you tab into that cell, the choice list will show your extra choices as well a
original choices.

Help Messages for Cells

Each cell on a form can display a custom help message created by the form designer. The he
sage contains useful information or special instructions on filling in the cell. Help messages a
played on the Help dialog. If you’re using a computer with Mac OS System 7 (or later), they a
appear in help balloons.

Note When you add extra choices, they are only available for the cell that you added them in. In o
words, the extra choices will not appear in other cells, even if they use the same choice lis
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To display the help dialog, first select the cell, then choose Help... from the Cell menu, or press 
Control-? (Windows) or Command-? (Mac OS). The Help Message dialog box appears:

On the Mac OS, to display the Balloon help, choose Show Balloons from the Help menu and point 
at the cell of interest. A balloon appears showing the cell’s help message:

To turn off the Balloon help, choose Hide Balloons from the Help menu.

Check Formulas and the Help Dialog

As discussed in “Data Verification,” a cell’s check formula can append a message to the help
sage. You might, therefore, see a different message on the help dialog depending on the valu
current cell.

When a check formula uses an alert or help message, the message is added to the cell’s cus
message. The check formula message is separated from the cell’s help message by a dashe
the Help dialog.

The check formula message will remain part of the help message until you change the cell’s
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Lookups

The form designer can configure forms to look up information so that you don’t have to. Enter
part number on an invoice form, for example, could look up related inventory information in 
another data document or database and fill it in on the form. Lookups reduce the amount of 
necessary to fill out a form and improve the accuracy of the information entered.

The cell in which you enter information that’s looked up is called the lookup cell. In the figure 
above, the part number cell is the lookup cell.

Informed Filler can look up information in other form data documents and in other information
tems. An information system can range anywhere from a small database running locally on y
computer, to a high capacity, high performance SQL database running on a mainframe. The 
where Informed Filler looks up information is called the lookup source. Lookups are configure
the form designer.

Informed Designer and Informed Filler include built-in support for looking up into form data d
ments, or information available through Mac OS applications that support Apple events or Ap
Script. Other types of lookup sources are accessed using Informed data access plug-ins. Dat
plug-ins must be installed in your plug-ins folder.

A lookup is performed whenever you enter a value in a lookup cell and press Tab to leave th
You might be prompted to enter some information, such as your name and a password, whe
lookup is performed. This depends on the particular lookup source and how the connection i
figured. The form designer can include the necessary connection information in the form tem
itself or leave it blank.

For example, for lookups that query an Oracle database, if the form designer did not include 
ID and password in the form template, you’ll see the Oracle connection dialog box when the lo
is triggered.

Company 
Database

Value in lookup cell
is searched for.

Related information is
filled in on the form.
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The exact appearance of the connection dialog box varies slightly depending on the type of l
source.

When a lookup is performed, the value that you type in the lookup cell is searched for in the lo
source. If a single match is found, the related information is returned and entered automatica
the form. If the search fails, you’ll see a message indicating so. If multiple matches are found
might see a dialog box requesting that you select a single match.

If this happens, select the desired match then click ‘OK.’ To cancel the lookup, click ‘Cancel’ 
instead.

Lookup Errors

When you trigger a lookup, it is necessary that the lookup source be available to perform the
lookup. If Informed Filler is unable to find or connect to the lookup source, you’ll see an error
sage indicating so.

Depending on the type of lookup source, the specific error message and the options availabl
vary. For some lookup sources, the error is described and the lookup is canceled. For others, 
include skipping the lookup and looking for the lookup source.
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Clicking ‘Look’ allows you to try and locate the lookup source. For example, if the lookup sour
a form data document and Informed Filler cannot find the document, clicking ‘Look’ on this di
box allows you to browse any available volumes to locate the document. Clicking ‘Skip’ ignor
the lookup that time only. This means that the error message will appear the next time the loo
attempted. The ‘Disable’ option ignores the lookup until the data document is closed and late
opened again. For some lookup sources, the ‘Look’ option is not available. Instead, you’ll see
ton labeled ‘Retry.’ Clicking ‘Retry’ attempts to perform the lookup again.

Form Numbers

Forms such as invoices and purchase orders often contain unique numbers for identification
poses. Each time you fill out a form, you enter a new form number. The form designer can co
ure a cell that contains the form number to be an auto-incrementing cell—that is, a cell that’s
automatically assigned a value upon request or when a new record is added to the data doc

Form numbers can be obtained from a variety of sources. For instance, the next available nu
might be stored in the form template itself, or it can be obtained from another application or d
source. Data sources are accessed using Informed’s data access plug-ins.

If the auto-incrementing cell obtains its number from another data source, you might be prom
for some information such as a name and password when the form number is requested. Th
depends on the particular form number source and how the connection is configured. The fo
designer can include the necessary connection information in the form template itself or leav
blank.

For example, for cells that obtain a value from an Oracle database, if the form designer did n
include a user ID and password in the form template, you’ll see the Oracle connection dialog
when the auto-increment is triggered.
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The exact appearance of the connection dialog box varies slightly depending on the type of f
number source.

In cases where the source of your form numbers is unavailable, you can use the Assign Nex
command to obtain values at a later time. For example, suppose you’re waiting at an airport 
on a business trip and you want to fill out an expense form that gets its number from an Orac
base back at your office. You can fill out the entire form except for the form number. Then, wh
you return to your office, you can connect to your network and choose Assign Next Value from the 
Cell menu (with the form number cell selected). Informed Filler obtains the next available val
from the Oracle database, and fills in the cell on your form.

The Assign Next Value command is also used for cells that are configured to auto-increment
ally (that is, only when you request a value). To manually obtain the next available value for a
first select the cell, then choose Assign Next Value from the Cell menu.

You can manually assign values to multiple records on the Record List. With the collected re
displayed in the Record List window, select the column that contains the cells that require va
and choose Assign Next Value from the Cell menu. Informed Filler obtains the next available va
ues and assigns them to the selected cells. For information on how to find a collection of rec
and how to use the Record List, see Chapter 8, “Manipulating Records.”

Form Number Errors

When a form number is requested, it is necessary that the source of the form number be avai
generate the next available value. If Informed Filler is unable to find or connect to the form nu
source, you’ll see an error message indicating so.

Depending on the type of form number source, the specific error message and the options av
will vary. For some form number sources, the error is described and the auto-increment is can
For others, options include skipping the auto-increment and looking for the form number sou

Clicking ‘Look’ allows you to try and locate the form number source. For example, if the form
number source is another application and Informed Filler cannot find the application, clicking
‘Look’ on this dialog box allows you to browse any available volumes to locate the application
Clicking ‘Skip’ ignores the auto-increment that time only. This means that the error message 
appear the next time a form number is requested. The ‘Disable’ option ignores the auto-incre
until the data document is closed and later opened again. For some form number sources, th
‘Look’ option is not available. Instead, you’ll see a button labeled ‘Retry.’ Clicking ‘Retry’ 
attempts to perform the auto-increment again.
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